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THÔNG TIN CHUNG VỀ MÔN HỌC

- Số tiết: 30 (lý thuyết và thực hành)

- Hình thức thi: Thực hành trên máy tính

- Kiểm tra giữa kỳ: 50% số điểm

- Thi cuối kỳ: 50% số điểm
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MỤC TIÊU MÔN HỌC 

Sau khi học xong môn này, học viên có khả năng:

1. Thiết lập được môi trường vẽ trên Autocad (định

giới hạn bản vẽ, thiết lập kiểu chữ viết, kích thước,

layer)

2. Sử dụng được các lệnh vẽ thông dụng

3. Sử dụng được các lệnh hiệu chỉnh thông dụng

4. Vẽ được các hình 2D, 3D cơ bản

5. Thiết kế được các bản vẽ cơ bản trong xây dựng.
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NỘI DUNG CHƯƠNG TRÌNH  HỌC 

Chương 1: Làm quen Autocad 2007

Chương 2: Các lệnh vẽ thông dụng

Chương 3: Thiết lập chế độ vẽ

Chương 4: Các lệnh hiệu chỉnh thông dụng

Chương 5: Vẽ hình 3D (Tham khảo)

Chương 6: Hiệu chỉnh hình 3D (Tham khảo)

Chương 7: Các lệnh vẽ bổ sung trong Autocad

Bài tập tổng hợp
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1.1.1. Khởi động Autocad

Có 2 cách:

- Cách 1: Nhấp đúp chuột trái vào biểu tượng

trên màn hình destop xuất hiện màn hình Autocad.

- Cách 2: Vào Start  All Programs  Autodesk 

Autocad 2007  xuất hiện màn hình Autocad.

1.1.2. Mở màn hình sẵn sàng để vẽ

File → New → bảng Select template → acad → xuất 

hiện màn hình làm việc mới.

Chương 1: LÀM QUEN VỚI AUTOCAD 2007

1.1. CÁC THAO TÁC BAN ĐẦU
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Hình 1.1. Hình khởi động Autocad 2007
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9Hình 1.2. Bảng chọn kiểu bản vẽ

Nhấp chuột chọn

chữ acad, sau đó

nhấn Open sẽ mở

ra 1 file mới

Hình 1.2. Chọn kiểu bản vẽ
Ngoâ Baûo
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Hình 1.3. Màn hình Autocad sẵn sàng để vẽ (đã chuyển sang màu trắng)

Khu vực vẽ

Thiết lập sợi tóc con trỏ như 

hình trên là thích hợp nhất!
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1.1.3. Định giới hạn bản vẽ A4 (210 x 297):

Mvsetup  enter  n  enter  m  enter  1  enter

 210  enter  297  enter (dành cho tỉ lệ bản vẽ là 1:1)

Lúc đó, ta có màn hình có trang giấy A4 đứng.

Tương tự: A3 (420 x 297), A0(1189 x 841)

1.1.4. Đổi màu màn hình

Autocad mặc định màn hình màu đen hoặc xám. Nếu

không thích màu này, ta có thể đổi như sau:

Tool → Options → bảng Options → Chọn thẻ Display →

Nhấp chọn Color → xuất hiện bảng Drwings Window Color.

Trong khung Color, chọn màu trắng (White) → Nhấp Apply &

Close → Apply → OK→ màn hình làm việc màu trắng.

1.1.5. Tắt/ mở các thanh công cụ

Khi vừa khởi động, Autocad đã mặc định mở trước khoảng

4 thanh công cụ. Nếu muốn tắt thanh nào, ta chỉ cần nhấp vào

dấu X trên thanh đó.
Ngoâ Baûo
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Autocad có trên 30 thanh

công cụ (Toolbars). Thông

thường, ta chỉ cần dùng

khoảng 10 thanh công cụ có

dấu tick () như hình bên.

Để tắt/ mở các thanh công

cụ đó, ta để chuột gần phía

trên những thanh công cụ

đã được Autocad mặc định

mở sẵn, ta nhấp chuột phải

thì lập tức ta có danh sách

trên 30 thanh công cụ (xem

hình bên). Ta đánh tick vào

những thanh công cụ cần

dùng (mở), khi không dùng

nữa thì ta bỏ tick (tắt).
Ngoâ Baûo
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Các thanh công cụ thường dùng nhất như sau:

Thanh này để hiệu 

chỉnh đối tượng

Thanh này để gán chữ 

viết, kích thước

Thanh này để chỉ biểu 

tượng của đối tượng 

(lệnh vẽ)

Thanh này để chỉ 

đường nét, màu sắc

Thanh này để chỉ các thao tác chung như mở file mới, lưu, copy, …

Hình 1.4. Vài thanh công cụ
Ngoâ Baûo
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1.1.6. Các phím tắt thường dùng

Phím tắt Công dụng

F3 Tắt/ mở truy bắt điểm thường trú (OSNAP)

F5 Chuyển mặt của hình chiếu trục đo

F6 Tắt/ mở hệ tọa độ

F7 Tắt/ mở lưới

F8 Tắt/ mở chế độ tạo đường thẳng đứng/ ngang

F9 Tắt/ mở snap (bước nhảy con trỏ)

Shift + chuột phải Gọi bảng danh sách truy bắt điểm tạm trú

Esc Hủy bỏ lệnh

Enter, Space bar Kết thúc lệnh, lặp lại lệnh mới

Ctrl + Z Indo (trở về trước 1 lệnh)

Ctrl + Y Redo (trở về sau 1 lệnh)

Ctrl + C Copy (sao chép)
Ngoâ Baûo
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Ctrl + V Past (dán) Rev Quay khoái troøn xoay

Ctrl + S Save (lưu) Su Caét hình 3D

Ctrl + P Plot (in) Ngöôøi hoïc boå sung tieáp theo

Ctrl + X Cut (cắt bỏ)

L Line (vẽ đường thẳng)

C Circle (vẽ đường tròn)

Co Copy (sao chép)

Mi Mirro (đối xứng)

Ex Extend (kéo giãn)

X Tách nhóm

Cha Chamfer (vát mép)

F Fillet (bo tròn)

Le Leader (vẽ mũi tên)

T Text (đánh chữ)
Ngoâ Baûo
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A Arc (vẽ cung tròn)

Pol Polygon (vẽ đa giác)

Mo Modify (mở bảng hiệu chỉnh)

Ma Match property (làm giống đặc tính)

Tr Trim (cắt bỏ)

M Move (di chuyển)

Ro Rotate (quay)

Sc Scale (thu nhỏ/ phóng to đối tượng)

Ar Array (sao chép dãy)

Z Zoom (phóng to/ thu nhỏ màn hình)

Z enter A enter Thu đối tượng về giữa màn hình

El Vẽ elip

Ext Taïo khoái

Reg Taïo mieàn kín

Ngoâ Baûo
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1.1.7. Sử dụng các lệnh về file trong Autocad

Tương tự như các lệnh về file của các phần mềm khác.

a) Mở file mới

Nhấp đúp biểu tượng Autocad ngoài Destop, sẽ tạo ra màn

hình làm việc của Autocad.

b) Mở file có sẵn

Từ màn hình Autocad  file  open  chọn ổ đĩa chứa file

cần mở nhấp đúp file cần mở.

c) Lưu file Autocad

Ctrl + S  hộp thoại Save drawing as  đặt tên file vào file

name, chọn vị trí cần lưu tại Save in  Save.

Chú ý: Đôi lúc chúng ta cần lưu file ở phiên bản autocad thấp

hơn để máy tính có cài phiên bản đó mở được. Ta làm như

sau: Ở hộp thoại Save drawing as, trong ô Files of type, ta

chọn kiểu lưu khác (ví dụ: chọn Autocad 2004, …).
Ngoâ Baûo
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d) Đóng bản vẽ (thoát Autocad): Có nhiều cách

- Cách 1: Nhấp vào dấu X màu đỏ phía trên bên phải màn

hình Autocad. Nếu muốn lưu thì chọn Yes, ngược lại chọn No.

Quy trình lưu như trình bày ở mục c.

- Cách 2: Nhấp chuột phải vào phía dưới cùng của màn hình

Autocad, sau đó nhấp close. Nếu muốn lưu thì chọn Yes,

ngược lại chọn No. Quy trình lưu như trình bày ở mục c.

- Cách 3: Vào File  Exit

1.2. CÁC THAO TÁC ĐƠN GIẢN NHẤT THƯỜNG DÙNG

a) Thoát khỏi lệnh vẽ: Nhấn nút Esc

b) Xóa đối tượng: Rê chuột, bao chọn hết đối tượng cần xóa,

nhấn Delete.

Cách khác: Nhấn E, enter, bao chọn đối tượng, enter.

Ngoâ Baûo
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Chú ý: Rê chuột bao chọn đối tượng từ trái sang phải ta phải

bao hết đối tượng thì đối tượng mới được chọn; còn bao chọn

đối tượng từ phải sang trái ta chỉ chọn một phần đối tượng thì

cả đối tượng được chọn.

c) Đưa màn hình vào trạng thái dễ phóng to, thu nhỏ: Nhấn

Z, enter, A enter.

e) Đưa hệ trục tọa độ về phía góc trái màn hình:

View > Display > UCS Icon > Nhấp bỏ dấu chọn Origin.

f) Tạo cách vẽ đường thẳng đứng/ ngang: Nhấn F8

g) Vẽ đường thẳng:

L, enter, nhấn 1 điểm tùy ý trên màn hình, kéo chuột ra (trái,

phải, lên, xuống) nhập độ dài, enter. (Nhớ nhấn F8 để có

đường thẳng đứng/ ngang).

Ngoâ Baûo
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Thực hành:  Vẽ tam giác đều cạnh 50:

+ L, enter, nhấp chọn 1 điểm tùy ý, kéo sang phải, nhập độ

dài đường thẳng là 50, enter.

+ Gõ @50<120, enter, nhấp chọn điểm cuối cạnh đáy hoặc

nhấn C, enter (C có nghĩa Close, là đóng tam giác).

h) Truy bắt điểm thường trú:

Nhấn F3 (tắt/ mở) truy bắt điểm thường trú)

i) Thiết lập truy bắt điểm thường trú:

Để chuột phải vào OSNAP (trên thanh trạng thái, phía dưới

màn hình) > nhấn chuột phải > Setting > xuất hiện bảng 1 >

ta đánh dấu chọn/ bỏ chọn các truy bắt điểm).

Ghi chú: Chỉ nhấn dấu tick () vào End point, Middpoint,

Center. Không nên chọn nhiều tick, vì như vậy Autocad sẽ truy

bắt điểm liên tục, gây khó vẽ.

Ngoâ Baûo
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Điểm cuối

Trung điểm

Tâm đ. tròn

Điểm

Điểm giao 

nhau

Tiếp điểm

Vuông góc

Hình 1.5. Bảng truy bắt điểm thường trú Ngoâ Baûo
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k) Truy bắt điểm tạm trú:

Nhấn tổ hợp phím Shift + Chuột phải > bảng truy bắt điểm

> buông phím Shift > chọn loại truy bắt điểm tùy thích.

l) Điều chỉnh chế độ vẽ (các dấu chọn, dấu truy bắt điểm):

Để có chế độ dễ vẽ nhất, ta chỉnh bên trong Autocad như

sau: Tool > Options > xuất hiện bảng Options > Mở các trang

trong bảng Options (có 10 trang), kéo các Con chạy tùy

chỉnh vào khoảng giữa > Apply > OK.

m) Chỉnh độ mịn đường tròn (không bị đa cạnh):

Tool > Options > Display resolution (nhập 20000)

n) Làm giống đặc tính (làm các đường giống nhau về màu,

nét, …):

Gõ Ma > enter > nhấp chuột chọn đường mẫu > nhấp chuột

chọn đường cần làm giống.

Ngoâ Baûo
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p) Vẽ đường đứt (gạch gạch)

Bước 1: Vẽ đường thẳng liền (Continue)

Bước 2: Vào Bylayer (nút giữa của thanh Properties) >

Others > Load > xuất hiện bảng > Chọn đường đứt như ý

muốn (đường HIDDEN hoặc đường đầu tiên trong bảng).

Bước 3: Khi vẽ xong, nếu khoảng đứt nhỏ thì không nhìn thấy

đứt, lúc đó, ta làm theo kinh nghiệm như sau:

+ Chọn đường thẳng đó.

+ Gõ mo > enter > xuất hiện bảng > chỉnh tỉ lệ trong bảng (vào

Linestype Scale, điền số từ 0.1 tới 50 tùy thích khoảng đứt

dài hay ngắn).

+ Nhấn nút X trên góc phải của bảng để tắt bảng.

Ngoâ Baûo
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q) Vẽ đường tâm:

+ Làm tương tự như vẽ đường đứt, nhưng Load đường

CENTRER 2.

+ Chỉnh tỉ lệ khoảng cách cũng giống như chỉnh đường đứt.

r) Tạo đường nét đậm / nhạt:

Chọn đường > vào Bylayer (nút thứ 3 của thanh Properties)

> chọn đường nét đậm / nhạt tùy thích.

(Nhớ nhấn chuột tắt / mở nút LWT ở thanh trạng thái dưới

màn hình để thể hiện nét đậm của đường).

s) Tạo màu cho nét vẽ:

Chọn đường vẽ > vào Bylayer (nút thứ 1 của thanh

Properties) > chọn màu sắc tùy thích.

t) Phóng to / thu nhỏ bản vẽ:

Lăn chuột giữa

Ngoâ Baûo
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u) Di chuyển màn hình bản vẽ:

Nhấn giữ chuột giữa, di chuyển qua lại.

v) Gõ chữ:

T > enter > rê chuột chọn 1 vùng > gõ chữ tùy thích > xong

nhấn OK trên thanh Text Formattion.

x) Chỉnh chữ:

Nhấn đúp chuột trái (nhấp 2 cái) vào chữ > Xuất hiện bảng

chế độ sửa chữ > bôi đen chọn chữ > thay đổi font chữ và cỡ

chữ trên thanh Text Formattion > OK.

y) Ghi mẫu tự Hylạp, ví dụ: ω, , ε, φ, …

T > enter > rê chuột chọn 1 vùng > nhấn chuột phải > xuất

hiện bảng > Symbols > Others > Xuất hiện bảng (hình 1.6) >

chọn mẫu tự tùy thích > nhấn Select > nhấn Copy > nhấn nút

– để giấu bảng hình 1.6 > Nhấn Ctrl + V.

Ngoâ Baûo
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Hình 1.6. Bảng các mẫu tự hay dùng
Ngoâ Baûo
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z) Ghi kích thước đường kính vòng tròn (Φ13, Φ16, …)

Dimention > Linenear > chọn 2 điểm gióng > M > enter > Để 

chuột phía trước số > Gõ %%c > OK.

Hoặc:  Dimention > Diameter > Chọn vào vòng tròn.

w) Hiệu chỉnh kích thước:

Cách 1: Khi màn hình ở chế độ đang ghi kích thước > gõ M > 

enter > sửa giá trị kích thước > OK.

Cách 2: Chọn đường kích thước cần sửa > nhấn ed > sửa kích 

thước tùy thích.

Ngoâ Baûo
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Chương  2: CÁC LỆNH VẼ THÔNG DỤNG

2.1. THANH CÔNG CỤ DRAW

Khi vừa khởi động Autocad, thanh Draw được mặc định

nằm phía trái màn hình. Bạn nhấp vào biểu tượng nào trên

thanh Draw là bạn đang thực thi lệnh vẽ hình gần giống như

biểu tượng đó.

Hình 2.1. Thanh công cụ Draw
Ngoâ Baûo
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Hình 2.2. Tương ứng giữa thanh công cụ Draw và menu Draw

Đôi khi

bạn không

thích hoặc

không quen

dùng thanh

Draw thì

bạn dùng

phím tắt

hoặc dùng

menu Draw

xổ xuống

như hình

bên.
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2.2. CÁC LỆNH VẼ

- L (hay dùng biểu tượng       )

- LINE Specify first point: Nhấp chuột trái chọn điểm P1.

- Specify next point or [Undo]: @ 0,100        (Điểm P2)

Cách khác:

- L (hay dùng biểu tượng )

- LINE Specify first point: Nhấp chuột trái chọn điểm P1.

- F8 (Mở ORTHO), rê chuột sang trái.

- Specify next point or [Undo]: 100       (Điểm P2) 





2.2.1. Vẽ đường thẳng

Lệnh này dùng rất nhiều trong bản vẽ kỹ thuật, tất cả các

loại đường (không phải là đường cong) thì có thể vẽ bằng

đường thẳng. Sau đây là cách thực hiện lệnh vẽ:

P2P1




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2.2.2. Vẽ đường tròn

- C (hay dùng biểu tượng )

- Specify center point for circle or

[3P/2P/Ttr (tan tan radius)]: Nhấp chuột

trái chọn điểm O.

- Specify radius of circle or [Diameter]:

100 (Bán kính 100 mm).



O

Ghi chú: Ở dòng lệnh thứ 2 [3P/2P/Ttr (tan tan radius)], có

nghĩa là ta có 3 cách khác để vẽ đường tròn như sau:

• 3P: Nhấp chuột trái chọn 3 điểm

• 2P: Nhấp chuột trái chọn 2 điểm (tạo thành đường kính)

• Ttr (tan tan radius): Nhấp chuột trái chọn 2 điểm tiếp xúc và 

nhập giá trị bán kính.



Ngoâ Baûo
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A

C

B A B

R
25

A BO

a)

b)

d)

c)

Hình a): Vẽ tam

giác đều; vẽ đường

tròn qua 3 điểm A,

B, C (3P).

Hình b): Vẽ góc

600, vẽ đường tròn

qua 2 điểm A, B, và

bán kính R25 (ttr)

Hình c): Vẽ đường

tròn qua 3 điểm A,

B, C (3P, nhấp

chuột 3 điểm).

Hình d): Vẽ đường

tròn qua 2 điểm A,

B, (2P, nhấp chuột

2 điểm).

Ngoâ Baûo
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2.2.3. Vẽ hình chữ nhật

Ta muốn vẽ hình chữ nhật có kích thước

như hình bên.

- Rectangle (hay dùng biểu tượng )

- Specify first corner point or [Chamfer/

Elevation/ Fillet/ Thickness/ Width]: Nhấp

chuột trái chọn điểm tùy ý.

- Specify other corner point or 

[Dimensions]: @100,80

8
0

100

Chú ý:

1/ Độc giả hãy tự tìm hiểu các tùy chọn ở dòng lệnh thứ 2:

(Chamfer/ Elevation/ Fillet/ Thickness/ Width).

2/ Ta có thể vẽ hình chữ nhật như trên bằng cách dùng lệnh L.





Ngoâ Baûo
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2.2.4. Vẽ cung tròn

Ta muốn vẽ hình một cung tròn

như hình bên.

- A (hay dùng biểu tượng )

- Specify start point of arc or

[Center]: Nhấp chuột trái chọn

điểm tùy ý, ví dụ điểm A.

- Specify second point of arc or

[Center/End]: C



R100

A

B

- Specify center point of arc: 100

- Specify end point of arc: Nhấp chuột trái chọn điểm tùy ý (ví

dụ điểm B).

Ghi chú: Có thể vẽ cung tròn bằng cách vẽ đường tròn, sau đó

cắt bỏ đi một đoạn cung nào đó (dùng lệnh tr, xem chương 4)




Ngoâ Baûo
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2.2.5. Vẽ elip

Ta muốn vẽ hình elip có kích thước

như hình bên.

- F8 (mở ORTHO)

- El (hay dùng biểu tượng )

6
0

100

- Specify axis endpoint of ellipse or [Arc/Center]: Nhấp chuột

trái chọn điểm tùy ý

- Specify other endpoint of axis: 100

- Specify distance to other axis or [Rotation]: 30

Chú ý:

- Nếu không mở ORTHO thì 2 trục của elip tạo thành không

nằm ngang hay thẳng đứng.

- Tại dòng lệnh thứ 3, nếu ta gõ phím a thì ta vẽ cung elip, nếu

ta gõ phím c thì ta vẽ elip có tâm và nửa độ dài của 1 trục.





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2.2.6. Vẽ đa giác đều

Ta muốn vẽ hình lục giác đều có kích 

thước như hình bên.

- F8 (mở ORTHO)

- Pol      (hay dùng biểu tượng         )

- POLYGON Enter number of sides <4>: 6

100



- Specify center of polygon or [Edge]: Nhấp chuột trái chọn

điểm tùy ý để làm tâm (ví dụ điểm A).

- Enter an option [Inscribed in circle / Circumscribed about

circle] <I>:

- Specify radius of circle: 50 (bán kính đường tròn ngoại tiếp

là 50 mm).







A

(Đồng ý với tùy chọn đa giác cần vẽ nội tiếp trong đường tròn)
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Chú ý:

1/ Tại dòng lệnh thứ 5, nếu ta không

chấp nhận I (là Inscribed in circle – đa

giác cần vẽ nội tiếp trong đường tròn)

mà ta gõ phím C (là Circumscribed

about circle - đa giác cần vẽ ngoại

tiếp đường tròn) thì lúc đó nếu ta vẽ lục

giác, ta sẽ được khoảng cách giữa 2

cạnh đối bằng đường kính đường tròn

nội tiếp (hình a).

2/ Ta cũng có thể dùng lệnh pol để vẽ

tam giác đều, hình vuông, ngũ giác đều,

… (hình b).

3/ Nếu ta không mở ORTHO thì đa giác

tạo ra không thẳng đứng được.

1
0

0

a)

b)
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2.2.7. Vẽ đường cong tự do

- Spl (hay dùng biểu tượng         )

- Specify first point or [Object]: Nhấp chuột 

trái chọn điểm tùy ý (ví dụ: chọn điểm A)

- Specify next point: Rê chuột nhấp điểm tiếp theo

(ví dụ: chọn điểm B)

- Specify next point or [Close/Fit tolerance] <start tangent>: Rê 

chuột nhấp điểm tiếp theo (ví dụ: chọn điểm C)

- Specify next point or [Close/Fit tolerance] <start tangent>: Rê 

chuột nhấp điểm tiếp theo (ví dụ: chọn điểm D). v. v …

(3 lần nhấn enter)

Ghi chú: Loại đường vẽ tự do này ít sử dụng.

 A

B

C

D



Ngoâ Baûo
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2.2.8. Vẽ miền kín

- Vẽ một vùng kín gồm các đường thẳng

tùy ý (hình a).

- Reg (hay dùng biểu tượng )

- Select objects: chọn tất cả các đường

thẳng hình a)

Lúc này các đường thẳng đã liên kết với

nhau, nếu chọn 1 đường thì tất cả các

đường khác cũng được chọn (hình b).

Lệnh này dùng nhiều khi vẽ hình 3D.




a)

b)

Chú ý:

1/ Khi muốn tách miền ra thành các đoạn riêng rẽ thì ta chọn

miền, nhấn x, nhấn enter.

2/ Hình đa giác, hình elip, hình tròn thì đương nhiên là miền,

không cần tạo.
Ngoâ Baûo
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2.2.9. Vẽ điểm

Trước khi vẽ điểm, ta cần

định dạng điểm là dấu chấm,

gạch chéo, dấu tròn hay dấu

cộng, …).

- Format > point style hộp

thoại hình bên. Chọn tùy ý

loại điểm nào đó > OK.

- Po

- Specify a point: Nhấp chuột

trái 1 điểm tùy ý, ta có điểm.

Ta có thể sửa số trong ô

Point Size để có điểm to,

nhỏ khác nhau.

Hình 2.3. Hộp thoại Point Style


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2.2.10. Chia đoạn thẳng hay đoạn cong thành nhiều phần

bằng nhau

- Vẽ đoạn AB (hình a).

- Div Select object to divide: Chọn đường thẳng vừa vẽ.

- Enter the number of segments or [Block]: 6

Như vậy, ta đã chia đoạn thẳng thành 6 đoạn bằng nhau

(hình a). Tương tự, ta cũng có thể chia đường tròn, cung tròn,

elip thành nhiều đoạn bằng nhau (hình b).

Đến đây ta có thể vẽ hình đa giá đều nội tiếp trong đường

tròn dễ dàng bằng cách dùng lệnh Div, sau đó dùng bảng truy

bắt điểm tạm trú, chọn NODE, dùng các đoạn thẳng nối các

điểm chia.




A B
a) b)

Ngoâ Baûo



42

Ngoâ Baûo



43

2.2.11. Vẽ mặt cắt

- Vẽ trước một vùng kín (ví dụ hình bên)

- H (hay dùng biểu tượng )

Xuất hiện hộp thoại hình 2.4.

- Nhấp Add: Pick points trong hình 2.4

- Select internal point: Nhấp vùng cần cắt (vùng trong)

- Sửa số liệu tại Angle và Scale trong bảng hình 2.4

(Nếu thấy mặt cắt tạo thành chưa phù hợp thì sửa lại số liệu

trong các khung này).

Hình 2.5 cho ta cách tạo mặt cắt theo kiểu tô màu tương

phản (gradient).

Hình 2.6 cho ta cách chọn các loại mặt cắt cần thiết. Hộp

thoại Hatch Pattern Palette có 5 trang, 2 trang thường dùng

nhất như đã chỉ ra ở hình 2.6.


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Hình 2.4. Hộp thoại Hatch and Gradient (trang Hatch) Ngoâ Baûo



45Hình 2.5. Hộp thoại Hatch and Gradient (trang Gadient)
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Hình 2.6. Hộp thoại Hatch Pattern Palette

Ngoâ Baûo
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Kết luận:

- Ta đã tìm hiểu qua các lệnh vẽ cơ bản, còn rất nhiều các

lệnh vẽ khác nữa, không thể kể hết được. Với các lệnh vẽ cơ

bản trên, ta có thể phối hợp chúng với nhau để thay thế các

lệnh vẽ khác.

- Khi thân thiện với Autocad, người vẽ có thể tự tìm hiểu các

lệnh vẽ mới. Tuy nhiên, nếu khai thác tốt các lệnh vẽ cơ bản

trên (cùng với các lệnh hiệu chỉnh ở chương 4) ta có thể vẽ

được mọi bản vẽ 2D.

Ngoâ Baûo
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2.3. NHẮC LẠI KIẾN THỨC VỀ VẼ KỸ THUẬT XÂY DỰNG

Ký 

hiệu

A0 A1 A2 A3 A4

Kích 

thước

1189 x 841 841 x 594 594 x 420 420 x 297 297 x 210

2.3.1. Khổ giấy

2.3.2. Canh lề bản vẽ và khung tên

5

25

5

5

KHUNG TÊN

Ngoâ Baûo

- Khung bản vẽ hình bên dùng

cho tỉ lệ 1 : 1

- Nếu bản vẽ có tỉ lệ 1:100 thì các

số hình bên tăng lên 100 lần.

- Kích thước khung tên có thay

đổi tùy cơ quan quy định.
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TỈ LỆ

NGÀY VẼ

KIỂM TRA

BÀI SỐ

(1)
(2)

(3)

(4)
(5)

(6)

Mỗi bản vẽ đều phải

có khung tên, đó là hình

chữ nhật vẽ bằng nét

liền đậm và luôn đặt ở

góc dưới bên phải của

bản vẽ. Nội dung và kích

thước khung tên do từng

cơ quan quy định. Hình

bên là dạng khung tên

dùng trong trường học.

(1)Ghi tên bản vẽ

(2) Ghi trị số tỉ lệ

(3) Ghi ngày vẽ xong

(4) Chữ ký người kiểm tra

(5) Ghi tên trường, lớp, tên người vẽ

(6) Ghi số thứ tự bản vẽ

2.3.3. Tỉ lệ

Thu nhỏ Nguyên hình Phóng to 

1:2, 1:10, 1;20, 1:25,1:50,     

1:100   1:400 …

1:1 2:1   10:1  …

Ngoâ Baûo
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2.3.4. Ghi tỉ lệ cho bản vẽ

Tỉ lệ là tỉ số chiều dài trên bản vẽ so với chiều dài thực địa. 

Ví dụ: Trên khổ A0, có một chiều dài nào đó là 800 (mm).

Nếu ta ghi tỉ lệ là 1:20 thì chiều dài trên thực địa sẽ là:

800.20 = 16000 (mm) = 16 (m)

Tỉ lệ chỉ ghi đúng khi người vẽ dự tính in bản vẽ trên loại

giấy cỡ nào (A4, A3, A2, A1, A0). Trong xây dựng, thường in

trên A0. Lúc đó, người vẽ phải tự tính được khoảng cách 1

đoạn nào đó trên bản vẽ so với khoảng cách ngoài thực địa

để ghi tỉ lệ bản vẽ cho đúng.

Nếu in chỉ để xem và chỉnh sửa bản vẽ thì nên in A4 cho

đỡ tốn kém.
Ngoâ Baûo
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2.3.4. Nét vẽ

Tên gọi Hình dạng Độ rộng nét Ứng dụng

Liền đậm 0.5 Đường cơ bản

Liền 

mảnh

0.25 Đường kích thước

Đường vật liệu, …

Nét đứt 0.25 Đường khuất

Chấm 

gạch

0.25 Đường tâm, đối xứng

Nét cắt 0.7

0.25

Dấu vị trí mặt phẳng 

cắt

Nét lượn 

sóng

0.25 Đường tự do, cắt lìa

Dích dắc 0.25 Đường cắt lìa

Gạch 2 

chấm

0.25 Đường bao

Ngoâ Baûo
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1 m 3m

1 m

Q

P

G

BA

Ø200

Ø150

BÀI TẬP CHƯƠNG 2

Hãy vẽ các hình sau:

Ngoâ Baûo
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240

120

6
0

4
5

4
0

6x 40

Ø50

Ø100

Ø60

Ø60

Ø30

Ø100

R
5
0

100

50
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240

120

6
0

4
5

4
0

6x 40

Ø50

Ø100

Ø60

Ø60

Ø30

Ø100

R
5
0
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6
0

4
5

4
0
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Ø50
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Ø60
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R
5
0
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120

6
0

4
5

4
0

6x 40

Ø50

Ø100
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Ø60
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R
5
0

12030

6
0
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2400
1

6
0

0
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Chương 3: THIẾT LẬP CÁC CHẾ ĐỘ VẼ 

TÓM TẮT

Trước khi bắt đầu thực hiện một bản vẽ Autocad, ta cần thiết lập các chế độ sau:

1. Định giới hạn bản vẽ (Limit): Việc này giúp người vẽ tập trung vào một vùng vẽ

trong môi trường Autocad, thuận lợi cho hiệu chỉnh, quản lý và in ấn sau này.

2. Định kiểu chữ viết (Text Style): Chữ viết phải phù hợp với tiêu chuẩn kỹ thuật và

giới hạn bản vẽ. Bản vẽ càng to thì chữ viết cũng to theo.

3. Định kiểu kích thước (Dimension Style): Ghi kích thước cũng phải phù hợp với

tiêu chuẩn kỹ thuật và giới hạn bản vẽ. Bản vẽ càng to thì kích thước cũng to theo.

4. Định đường nét, màu sắc, quản lý lớp (Layer): Việc này giúp người vẽ dễ dàng

gán hay hiệu chỉnh đường nét, màu sắc thống nhất trên toàn bản vẽ.

3.1. ĐỊNH GIỚI HẠN BẢN VẼ TỈ LỆ 1: 100

Ta thực hiện cho một khổ giấy trong các khổ giấy sau:

Gõ lệnh mvsetup  n  m  100  297  210  (khổ giấy A4 ngang)

Gõ lệnh mvsetup  n  m  100  210  297  (khổ giấy A4 đứng)

GHI CHÚ: Nếu ta muốn tỉ lệ khác (ví dụ:1:1, 1:20, 1:25, 1:50,1:200, …thì ta đổi số 

100 thành số 1 hoặc 20 hoặc 25 hoặc 50 hoặc 200, …)

Ngoâ Baûo
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3.2. ĐỊNH KIỂU CHỮ VIẾT CHO BẢN VẼ TỈ LỆ 1:100, in A4

BƯỚC 1: Vào Format > Text Styles > xuất hiện bảng 1 sau:

Bảng 1
Ngoâ Baûo
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BƯỚC 2: Từ bảng 1, vào New > xuất hiện hộp thoại New Text Style như sau:

Gõ “chu” vào Style Name của hộp thoại New Text Style như sau:

Xong, nhấn OK để trở về bảng 1, từ bảng này, ta nhập các thông số như bảng 2:

Ngoâ Baûo
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Xong, nhấn Apply → Close để đóng bảng 2. Kết thúc định kiểu chữ viết.

Bảng 2

BƯỚC 3: Từ bảng 2, trong ô Font Name, ta chọn kiểu chữ Arial, nhập 250 vào

khung Height để chỉ chiều cao chữ là 250pt.

250

Ngoâ Baûo
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3.3. ĐỊNH KIỂU KÍCH THƯỚC CHO BẢN VẼ TỈ LỆ 1:100 

BƯỚC 1: Vào Format > Dimension Styles > xuất hiện bảng 3 sau:

Bảng 3
Ngoâ Baûo
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BƯỚC 2: Từ bảng 3, vào New > xuất hiện hộp thoại Create New Dimension

Style như sau:

Ta gõ “kich thuoc” vào ô New Style Name.

Xong, nhấn Continue để xuất hiện bảng New Dimension Style, chọn trang

Symbols and Arrows trong bảng này, ta có bảng 4 như sau: Ngoâ Baûo
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BƯỚC 3: Nhập 1 vào ô Arrow size, chọn thẻ Oblique trong ô First và ô Second.

Bảng 4

1.0001

Ngoâ Baûo
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BƯỚC 4: Từ bảng 4, chọn trang Lines, điền các thông số như bảng 5 sau:

Bảng 5

(Khoảng vượt quá)

(Cách điểm gốc)

(Phần vượt quá)

1

3

1

Ngoâ Baûo
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BƯỚC 5: Từ bảng 5, chọn trang Text, điền các thông số như bảng 6 sau:

Bảng 6

(Chiều cao chữ)

(Tiêu chuẩn ISO)

(Khoảng cách giữa chữ và đường kích thước)

(Chữ nằm phía trên đường kích thước)

2.5

1

Ngoâ Baûo
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BƯỚC 6: Từ bảng 6, chọn trang Fit, điền các thông số như bảng 7 sau:

Bảng 7

(Tỉ lệ biến kích thước)

Ghi chú: Trong cùng 1 bản vẽ, ta có thể thiết lập nhiều kiểu kích 

thước đồng dạng với nhau bằng cách thay đổi tỉ lệ biến kích thước.

100100

Ghi chú:

Nếu một bản

vẽ mà có chữ

ghi kích thước

to, nhỏ khác

nhau thì ta

thay đổi số

100 trong ô

Use overall

scale of bởi

các số 200

hoặc 100 hoặc

khác nữa (bạn

đọc tự làm và

kiểm tra kết

quả trực tiếp

trên Autocad).
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BƯỚC 7: Từ bảng 7, chọn trang Primary Units, điền các thông số như bảng 8 sau:

Bảng 8

Ghi chú: Trong cùng 1 bản vẽ, ta có thể thiết lập 

nhiều kiểu tỉ lệ bằng cách thay đổi hệ số tỉ lệ.

(Hệ số tỉ lệ)

(Độ chính xác)

1

Ghi chú:

Nếu một bản

vẽ mà có nhiều

tỉ lệ khác nhau

thì ta thay đổi

số 1 trong ô

Scale factor

bởi các số 2

hoặc 0.5 hoặc

khác nữa (bạn

đọc tự làm và

kiểm tra kết

quả trực tiếp

trên Autocad).
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BƯỚC 8: Từ bảng 8, chọn trang Altermate Units, ta giữ như bảng 9 sau:

Bảng 9

(Hiển thị đơn vị thay thế)

Ta không check vào Display altermate units, ta không phải thiết lập gì trong bảng này

Nhìn hình

xem trước

như thế này

là quá trình

định kiểu

kích thước

đạt yêu cầu
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BƯỚC 9: Từ bảng 9, chọn trang Tolerances, ta giữ như bảng 10 sau:

(Hiệu chỉnh dung sai)

Ta  không phải thiết lập gì trong bảng này, nếu bảng vẽ cơ khí thì mới thiết lập dung sai

Bảng 10

BƯỚC 10: Từ bảng 10, nhấn chọn OK > Close để kết thúc thiết lập kiểu 

kích thước. Ngoâ Baûo



70

TÓM TẮT:  Thiết lập kích thước cho một bản vẽ xây dựng điển hình  tỉ lệ 1:100:

Thiết lập

Khổ giấy

Text 

height

Scale 

factor

Arrow 

size

Extend 

beyond 

Stick

Extend 

beyond 

dim lines

Offset 

from 

origin

Offset 

from 

dim 

lines

Use 

overall 

scale 

of

A4 

(210x297)

250 1 100 100 100 300 100 1

1. ĐỊNH GIỚI HẠN BẢN VẼ TỈ LỆ 1: 100

Gõ lệnh mvsetup  n  m  100  297  210  (khổ giấy A4 ngang)

2. CÁC THAY ĐỔI TRONG BẢNG DIMENSION STYLE

Cách 1: Ít dùng

Cách 2: Thường dùng

Thiết lập

Khổ giấy

Text 

height

Scale 

factor

Arrow 

size

Extend 

beyond 

Stick

Extend 

beyond 

dim lines

Offset 

from 

origin

Offset 

from 

dim 

lines

Use 

overall 

scale 

of

A4 

(210x297)

2.5 1 1 1 1 3 1 100

Ngoâ BaûoChú ý: Tùy khổ giấy in khác nhau mà các số liệu trên cũng khác nhau
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- Nếu trong cùng một bản vẽ có dùng nhiều tỉ lệ, ví dụ: tỉ lệ 1:100 và tỉ lệ 1:50 thì ta

định kiểu kích thước 2 lần, lần đầu dùng tỉ lệ 1:100 thì để Scale factor (trang

Primary Units) là 1, lần sau dùng tỉ lệ 1:50 thì để Scale factor là 0.5.

- Các thông số của bảng trên chỉ là kinh nghiệm. Hiện nay cũng chưa có quy định

thống nhất nào về các thông số này. Tùy người vẽ, khổ giấy vẽ, cơ quan nơi công

tác, … mà các thông số trên có thay đổi chút ít.

Thiết lập

Khổ giấy

Text 

height

Scale 

factor

Arrow 

size

Extend 

beyond 

Stick

Extend 

beyond 

dim lines

Offset 

from 

origin

Offset 

from 

dim 

lines

Use 

overall 

scale 

of

A4 

(210x297)

2.5 1 1 1 1 3 1 1

Chú ý: Nếu tỉ lệ 1:1 thì ta làm như sau:

1. ĐỊNH GIỚI HẠN BẢN VẼ TỈ LỆ 1: 1

Gõ lệnh mvsetup  n  m  1  297  210  (khổ giấy A4 ngang)

2. CÁC THAY ĐỔI TRONG BẢNG DIMENSION STYLE

Ngoâ Baûo
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3.4. ĐỊNH LỚP, ĐƯỜNG NÉT, MÀU SẮC (Layer)

BƯỚC 1: Đánh lệnh Layer hoặc Format > Layer sẽ xuất hiện hộp thoại Layer

Properties Manager như bảng 11:

Bảng 11

1 2

3 4 5 6 7 8 9

10

Ngoâ Baûo
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1 Tạo Layer mới

2

3

4

5

6

7

8

9

10

Xóa Layer

Tên Layer

Biểu tượng tắt, mở Layer. Khi tắt Layer thì các đường của Layer đó không

thể hiện trên màn hình bản vẽ nữa.

Biểu tượng đóng băng Layer. Khi Layer đóng băng thì không xuất hiện trên

màn hình bản vẽ.

Biểu tượng khóa Layer. Khi khóa Layer thì các đường nét của Layer đó vẫn

thể hiện trên màn hình bản vẽ, nhưng không thể xóa hay sửa được.

Màu đường nét

Loại đường nét (liên tục, khuất, đường tâm, …)

Độ đậm của đường nét (0.25; 0.3; 0.5; …)

Nhấn Check/ thôi Check khi cần đổi đặc tính Layer

Giải thích:

(Một số biểu tượng, thông số khác trong bảng 11 ít hoặc không cần thiết nên ta

không giải thích).
Ngoâ Baûo
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BƯỚC 2: Nhấn chuột trái liên tiếp nhiều lần vào ở bảng 11, ta có các Layer

mới tạo ra như bảng 12:

1

Bảng 12
Ngoâ Baûo
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BƯỚC 3: Đặt tên và gán thuộc tính cho các Layer

1. Chọn Layer 1, thì cả dòng của Layer 1 chuyển sang màu xanh. Nhấn chuột trái

vào chữ Layer 1 và đổi tên khác quen thuộc hơn, ví dụ: DUONG CO BAN

- Nhấp vào White để ra bảng màu và đổi màu Layer theo ý muốn

- Nhấp vào Default, có hộp thoại Linewieght xuất hiện, ta chọn loại đường 0.5.

Xong, nhấn OK đóng hộp thoại.

2. Chọn Layer 2, thì cả dòng của Layer 2 chuyển sang màu xanh. Nhấn chuột trái 

vào chữ Layer 2 và đổi tên khác quen thuộc hơn, ví dụ: DUONG KICH THUOC

- Nhấp vào White để ra bảng màu và đổi màu Layer theo ý muốn

- Nhấp vào Continuous thì có hộp thoại Select Linetypes xuất hiện.Nhấn

Load trong hộp thoại này và xuất hiện thêm hộp thoại khác nữa là Load or

Reload Linetypes. Trong hộp thoại Load or Reload Linetypes ta chọn loại

đuường là Center2. Xong, nhấn OK đóng hộp thoại Load or Reload Linetypes.

Tiếp theo, trong hộp thoại Select Linetypes đã thấy có đường Center2, ta chọn

lại đường Center2 và nhấn OK đóng hộp thoại này.

- Nhấp vào Default, có hộp thoại Linewieght xuất hiện, ta chọn loại đường

0.25. Xong, nhấn OK đóng hộp thoại.

3. Các Layer khác ta làm tương tự. Kết quả ta có như bảng 13
Ngoâ Baûo
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Bảng 13

10

- Để xóa Layer, ta chọn Layer và nhấn vào nút

- Để thay đổi thuộc tính Layer ta nhấn vào dấu Check , sau

đó nhấn chuột trái vào chỗ cần thay đổi thì ta thay đổi được dễ

dàng.

2

2

10

Ngoâ Baûo
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BƯỚC 3: Nhấn chuột vào Apply và OK đóng bảng 13, kết thúc quá trình thiết lập

Layer. Trở lại màn hình Autocad, trên thanh công cụ Layers, ta có các loại đường

nét, màu sác mà ta đã tạo được như bảng 14 sau:

Bảng 14

Khi đã tạo được Layer, ta muốn vẽ loại đường nào thì ta chọn Layer đó ở chế

độ hiện hành. Ví dụ, ta muốn vẽ đường tâm thì trên thanh công cụ Layer (bảng 14)

ta chọn DUONG TAM. Như vậy, khi vẽ ra ta sẽ thấy đường tâm kèm theo các thuộc

tính của nó mà ta đã định khi thiết lập Layer DUONG TAM.
Ngoâ Baûo
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KẾT LUẬN

Học Autocad, biết các lệnh vẽ, các lệnh hiệu chỉnh thì ta

chưa thể thực hiện một bản vẽ đúng kỹ thuật.

Người vẽ phải luôn luôn tự đặt ra và trả lời câu hỏi: “Ta

phải bắt đầu từ đâu để vẽ được bản vẽ kỹ thuật đạt hiệu quả

cao nhất?”.

Để bản vẽ Autocad thành công thì các công việc chuẩn bị

không thể thiếu là:

1. Định giới hạn bản vẽ

2. Định kiểu chữ viết

3. Định kiểu ghi kích thước

4. Định lớp (Layer), đường nét, màu sắc

Ngoâ Baûo
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BÀI TẬP CHƯƠNG 3

Tỉ lệ: 1.100

6

N3

2a a a a a

A

q

B

C

N5

N'4

4N

Q
P

N2

N1
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Định Layer, vẽ hình sau (đường tâm 0.25 màu đỏ, đường kích thước

0.25 màu xanh, đường cơ bản 0.5 màu đen).

Học viên nên thay

đường kích thước

dạng mũi tên sang

dạng gạch xiên 2

đầu.

Ngoâ Baûo
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21 21

CÁCH 

HIỆU 

CHỈNH

LỆNH HÌNH MINH HỌA

Hủy bỏ 

lệnh vừa 

thực hiện 

(undo)

U

hoặc Ctrl + z

(Xu hướng thường dùng

là nhấn Ctrl + z)

Từ hình 1, ta vẽ đường chéo

của hình chữ nhật như hình

2. Ngay sau đó, nếu ta không

muốn vẽ đường chéo này

nữa ta dùng UNDO, sẽ trở

lại hình 1.



Chương 4: HIỆU CHỈNH ĐỐI TƯỢNG

1 2
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21

Phục hồi 

đối tượng 

vừa undo 

(redo)

Redo

hoặc Ctrl + y

(Xu hướng thường dùng

là nhấn Ctrl + y)

Từ hình 1, ta vẽ đường

chéo của hình chữ nhật như

hình 2. Ngay sau đó, nếu ta

không muốn vẽ đường chéo

này nữa ta dùng UNDO, sẽ

trở lại hình 1. Nếu có hình

1 rồi, ta lại đổi ý, muốn trở

lại hình 2 thì ta dùng

REDO.



1 2
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Xóa đối 

tượng 

(Delete)

- Chọn đối tượng

- Nhấn phím Delete

Cách khác: Gõ E > enter >

chọn đối tượng > enter.

Chú ý khi chọn đối tượng:

- Giữ chuột trái và kéo từ trái

sang phải thì chỉ chọn được đối

tượng khi tạo được ô chữ nhật

bao toàn bộ đối tương.

- Giữ chuột trái và kéo từ phải

sang trái thì chọn được đối tượng

khi chỉ cần tạo được ô chữ nhật

bao 1 phần đối tương.

Đối tượng được

chọn (có các ô vuông

chọn nằm cách đều)
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Sao 

chép 

đối 

tượng 

(Copy)

 Co

 Chọn đối tượng

 Specify base point or

displacement: Nhấp một

điểm nào đó trên đối tượng

và rê chuột mang đối tượng

mới sao chép đi chỗ khác.

(hình bên là sao chép

đường tròn thành một

đường tròn khác)

Nhấp chọn tâm đường tròn 1

sao chép ra đường tròn 2.

Chọn tâm A và thả tại tâm B




1
2

A
B
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Lấy đối 

xứng 

qua 

đường 

thẳng 

(Mirror)

Hình 2 là ảnh của hình 1

qua phép đối xứng trục AB

 mi

 Chọn đối tượng

 Specify first point of

mirror line: Nhấp một

điểm A nào đó trên

đường cần lấy đối xứng.

 Specify first point of

mirror line: Specify

second point of mirror

line: Nhấp một điểm B

nào đó trên đường cần

lấy đối xứng.





1 2

B

A




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A'A

100Di 

chuyển 

đối 

tượng 

(Move)

Di chuyển đối tượng từ vị trí

A sang A’ (chọn A và thả tại

A’)

Chú ý: Chọn đối tượng,

sau đó nhấn chuột giữa

và kéo, cũng di chuyển

được đối tượng.

 M

 Chọn đối tượng

 Specify base point or

displacement: Nhấp một

điểm A nào đó trên đối

tượng.

 Specify base point or

displacement: Specify

second point of

displacement or

<use first point as

displacement>: 100

(nhập khoảng cách cần di

chuyển tùy ý).



A A’







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Tạo các 

đối 

tượng 

song 

song 

(Offset)

 Specify point on side to

offset: Nhấp một điểm bên

trong tam giác → ta được a’.

 Tương tự như trên, ta được

b’, c’.

Các đường thẳng a, b, c

được offset vào phía trong

của tam giác thành a’, b’,

c’ lần lượt cách cách a, b,

c 10mm.

Ta muốn ta các đường

a’, b’, c’ từ các đường a,

b, c như hình bên, sao cho

các đường a’, b’, c’ lần

lượt cách các đường a, b,

c 10 mm.

 O

 Specify offset distance or

[Through] <Through>: 10

 Select object to offset or

<exit>: Chọn đường a





a
a’ b’

c’

c

b

Ngoâ Baûo



89

Cắt đối 

tượng 

(Trim)

 tr

 Chọn đối tượng

 Chọn đường thẳng làm

“dao cắt”, ví dụ: đường

thẳng a ở hình 1)

 Chọn phần cần cắt bỏ,

ví dụ: phần 1 ở hình 1.

 






a
1

2 2

Trước cắt Sau  cắt 

Chuù yù:

- Phaûi choïn ñoái töôïng laøm dao caét tröôùc roài môùi choïn ñoái töôïng caàn

caét.

- Neáu ta caàn caét nhieàu ñöôøng cuøng luùc thì ta laøm nhö sau: tr → enter

→ bao choïn heát taát caû vuøng caàn caét → enter → nhaáp chuoät traùi vaøo

ñoaïn caàn caét.
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Kéo dài 

đối 

tượng 

chạm đối 

tượng 

khác 

(Extend)

Trước kéo dài    Sau kéo dài

a

b

c

d

ee

d

c

b

a

Ta muốn kéo dài các

đường thẳng a, b, c, d ra

chạm đường thẳng e. Ta

làm như sau:

 ex

 Chọn đường thẳng e

(đích)

 Lần lượt nhấp chuột trái

vào các đường thẳng a, b,

c, d.



Chuù yù: Neáu ta khoâng duøng leänh treân thì ta duøng caùch thuû coâng laø

nhaán chuoät traùi choïn ñöôøng thaúng vaø baét vaøo ñaàu noù keùo ra.
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Vát mép 

(Chamfer)

 Cha

 D

 Nhập độ dài mép vát 

thứ nhất: ví dụ nhập 1

 Nhập độ dài mép vát 

thứ hai: ví dụ nhập 1              

 Chọn 2 cạnh giao nhau

cần vát mép (ví dụ chọn

a và b của hình vuông

bên).

Tương tự, vát các mép 

còn lại.

Trước 

vát 

mép

Sau vát 

mép, vát 

mép mỗi góc 

bằng cạnh 

có độ dài 

2mm, 

nghiêng góc 

450 .








a

b

Chuù yù: Neáu ta voâ tình choïn ñoä daøi meùp vaùt lôùn hôn ñoä daøi caïnh thì

Autocad khoâng thöïc hieän ñöôïc.
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Bo tròn 

(Fillet)

 F

 R

 Nhập bán kính cong 

cần bo tròn: ví dụ nhập 

10

 Chọn 2 cạnh giao nhau

cần bo tròn (ví dụ chọn a

và b của hình vuông

bên).

Tương tự, bo tròn các 

góc còn lại.

Trước bo 

tròn

Sau bo 

tròn






a

b

Chuù yù: Neáu ta voâ tình choïn baùn kính bo troøn lôùn hôn ñoä daøi caïnh thì

Autocad khoâng thöïc hieän ñöôïc.
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Quay đối 

tượng 

quanh 1 

điểm 

(Rotate)

 Ro

 Chọn đối tượng (ví dụ 

chọn hình 1)

 Chọn tâm quay (ví dụ 

chọn điểm A)

 Chọn góc quay (ví dụ

chọn 30)

(ý nói góc quay là 300

theo chiều dương, tức

ngược chiều kim đồng

hồ. Nếu muốn quay theo

chiều âm thì ta nhập

– 300).

Trước 

quay 

Sau 

quay



A

21

A



1 2

A A
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Làm giống 

đặc tính đối 

tượng 

(Match 

properties)

 Ma

 Chọn đối tượng (ví dụ

chọn hình 1), con chuột

biến thành hình cây chổi.

 Chọn hình cần làm

giống (ví dụ chọn hình

2).

Chú ý: Việc làm giống

đặc tính giúp ta vẽ

nhanh hơn.

Trước làm giống



Sau làm giống

1 2

1 2

Chuù yù: Ñaëc tính laøm gioáng naøy giuùp ta veõ caùc baûn veõ nhoû, ñon giaûn

maø khoâng caàn thieát laäp Layer, sau khi veõ xong ta chæ caàn thöïc hieän

laøm gioáng.

Ngoâ Baûo



95

Bieán ñoåi tæ 

leä

 Sc

 Choïn ñoái töôïng (ví duï

choïn ñöôøng troøn 1)

 Choïn 1 ñieåm laøm taâm

(ví duï choïn A)

 Nhaäp giaù trò phoùng to

hay thu nhoû (ví duï nhaäp

2)

Tröôùc 

phoùng 

to



AA

1

2

Sau  

phoùng 

to







Chuù yù: Bieán ñoåi tæ leä thì kích thöôùc cuõng thay ñoåi theo. Ñeå kích thöôùc

khoâng ñoåi thì tröôùc khi thöïc hieän leänh Scale ta neân duøng leänh X ñeå

raõ ñöôøng kích thöôùc ra.
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Sao cheùp 

daõy (Ar)



 Ar (xuất hiện hộp

thoại Array),đánh dấu

chọn Rectangular

Array.

 Nhấp chuột trái vào

Select objects phía

trên bên phải hộp thoại.

 Chọn đối tượng >

Trở lại hộp thoại Array

> nhập giá trị cần sao

chép vào ô Rows và

Columns, sửa số trong

ô Row offset và

Column offset theo ý

muốn.

 OK



Trước 

sao 

chép

Sau sao 

chép
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Sao

chép

vòng

(Ar)



 Ar (xuất hiện hộp

thoại Array), đánh dấu

chọn nút Polar Array.

 Nhấp chuột trái chọn

vào Select objects phía

trên bên phải hộp thoại.

 Chọn đối tượng (ví dụ

chọn đường tròn 2) > Trở

lại hộp thoại Array > nhập

số cần sao chép vào ô

Total number of items >

Nhấp chọn vào nút Pick

center point > trở lại bản

vẽ, chọn điểm A làm tâm

Array.

 OK



Pick center point

Trước 

sao 

chép

Sau 

sao 

chép

1

2

A
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Hiệu

chỉnh

đường

nét

Ta muốn hiệu chỉnh đường

nét của hình 1 thành đường nét

của hình 2, 3, 4.

Trước khi làm điều này, ta hãy

tìm hiểu thanh Properties (hình

3.5). Giả sử ta vẽ đường tròn 1

bằng nét 0,3, đường tâm của nó

là nét 0,25. Bây giờ ta muốn đổi

nét hình 1 thành các nét như

hình 2, 3, 4. Ta chọn đường tròn

1 > nhấp vào Bylayer (cột

giữa), chọn đường nét khuất >

ta có đường tròn 2. Sau đó, ta

nhấp vào Bylayer (cột phải),

chọn nét 0,5, đường tròn 2 sẽ

đậm lên. Tương tự ta làm cho

hình 3 và 4.

4 3

21

4 3

21

4 3

21

4 3

21
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- Nhấp vào (1) sẽ có danh mục độ đậm/ nhạt của đường.

- Nhấp vào (2) sẽ có danh mục loại đường (liên tục, đường

tâm, khuất).

- Nhấp vào (3) sẽ có danh mục màu sắc của đường.

- Nhấp vào (4, chữ Others …) sẽ có hộp thoại hình 4.1. Từ

hộp thoại này, nhấp Load sẽ được hộp thoại hình 4.2. Trong

hộp thoại hình 4.2, cho phép ta chọn nhiều kiểu đường.
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Hình 4.1
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Hình 4.2
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BÀI TẬP THỰC HÀNH CHƯƠNG 4

1 2

Ngoâ Baûo



103

3

Ngoâ Baûo



104

4

Ngoâ Baûo



105

5

Ngoâ Baûo



106

6

Ngoâ Baûo



107

Chương 5: AUTOCAD 3D
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(ít dùng)
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Ghi kích thước hình 3D (cần nắm vững)

Ta hay dùng nút số 7 và 9 để ghi kích thước hình 3D
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BÀI TẬP CHƯƠNG 4

Ghi chú: Học viên dùng khổ giấy A4, định kích thước theo tỉ lệ 1:1 để vẽ hình trên.
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Ghi chú: Học viên dùng khổ giấy A4, định kích thước theo tỉ lệ 1:1 để vẽ hình trên.



137

Ghi chú: Học viên dùng khổ giấy A4, định kích thước theo tỉ lệ 1:1 để vẽ hình trên.
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Ghi chú: Học viên dùng khổ giấy A4, định kích thước theo tỉ lệ 1:1 để vẽ hình trên.
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Ghi chú: Học viên dùng khổ giấy A4, định kích thước theo tỉ lệ 1:1 để vẽ hình trên.
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Ghi chú: Học viên dùng khổ giấy A4, định kích thước theo tỉ lệ 1:1 để vẽ hình trên.



141



142

Chương  6: HIỆU CHỈNH HÌNH 3D
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Cho các hình 2D sau, hãy vẽ hình 3D (Dành cho SV cơ khí):
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Hãy vẽ 2 cái nhà trên (Mỗi kích thước thẳng đều tăng lên 30 lần)
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Chương 7: CÁC LỆNH BỔ SUNG TRONG AUTOCAD

1. In ấn trong Autocad

Hình 7.1. Bảng chế độ in trong Autocad
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Nhấp vào Window (hình 7.1)

thì trở lại màn hình Autocad, ta

khoanh vùng bản vẽ cần in như

sau: Nhấp chuột trái vào góc A

của bản vẽ, giữ và kéo chuột đến

góc B, rồi thả chuột, Autocad tự

động trở về bảng hình 7.1.

Nhấp chọn Review (hình 7.1)

để xem trước kết quả trang in.

Nếu khổ giấy in chưa thích hợp thì

nhấn phím Esc để trở lại hình 7.1.

Tiếp theo nhấp chuột trái vào

Portrait nếu muốn in giấy đứng,

nhấp chuột trái vào Landscape

nếu muốn in giấy ngang.

Sau đó, nhấp Review xem

lại trang in lần nữa, nếu được thì

nhấn phím Enter (2 lần), máy in

thực hiện lệnh in.

A

B
Hình 7.2. In bản vẽ khổ giấy A4
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Hình 7.3.
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2. COPY TỪ AUTOCAD SANG WORD

- Nếu ta copy một cách thông thường là chọn đối tượng bên

Autocad, nhấn Ctrl + C, sau đó sang màn hình Word nhấn

Ctrl + V thì thì ta được hình đối tượng cần copy. Cách làm này

không hay, vì khi ta in ra, đường nét bị mờ.

- Để đường nét copy từ Autocad sang Word không bị mờ, ta

dùng thềm phần mềm Better WMF. Phần mềm này bạn có thể

tải từ Web Furix.com. Phần mềm này rất dễ cài, bạn chỉ nhấn

vài lần Next như chỉ dẫn là cài được. Sau khi cài đặt xong,

phần mềm này có dung lượng 3,57 MB.

- Màn hình giao diện của Better WMF như hình 7.4 sau:
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Lựa chọn chung

Bỏ màu nền 

Autocad

Cắt viền ngoài 

của ảnh

Chuyển thành 

màu đen

Không hiệu 

chỉnh độ 

rộng nét

Hiệu chỉnh 

nét và chữ 

Tỉ lệ hình  

Màu tô 

Không hiệu 

chỉnh màu 

tô

Chuyển 

thành màu 

tô đen 

Quay ảnh 

Tỉ lệ thích hợp của 

ảnh (rộng, cao) 

Nhấp vào đây để có bảng hiệu chỉnh 

tiếp theo (xem hình 9.2)

Hình 7.4. Giao diện Better WMF
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Màu 

Autocad

Độ rộng 

nét

Nhấp 

chuột vào 

đây để 

chỉnh độ 

rộng nét 

màu đen

Điền giá 

trị độ 

rộng nét 

vào đây

Chuyển 

sang đường 

màu đen

Bỏ đường 

không 

cần thiết

Màu nét

Màu tô

Hình 7.5. Bảng hiệu chỉnh đường nét, màu sắc
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Sau đây, là cách sử dụng Better WMF:

 Mở Autocad, vẽ hình cần chuyển sang Word.

 Mở Word

 Mở Better WMF (giống như mở 1 chương trình thông

thường, lúc này ta được hình 7.4).

 Nhấn vào nút Advanced, rồi nhấn vào nút Edit của hình

7.4 để ra hình 7.5.

 Nhấn vào nút Color 7 để chỉnh nét màu đen. Điền 0.03

vào ô Edit value (inch). Thông thường nét 0.03 inch là thích

hợp, nếu không thích, bạn có thể nhập số khác số 0.03.

Sử dụng thêm các tùy chọn khác trên các bảng của hình

7.4 và 7.5 để hình copy từ Autocad sang Word thích hợp

nhất (bạn đọc nên làm nhiều lần mới quen).
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Sau đây, ta xét vài ví dụ thao tác copy hình từ Autocad sang

Word:

Hình 7.6a. Copy từ Autocad 

sang Word không dùng Better 

WMF (nét in ra rất mờ)

Hình 7.6b. Copy từ Autocad 

sang Word có dùng Better 

WMF (nét in ra như ý muốn)
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- Phần mềm Better WMF rất tiện lợi, nhưng bạn phải mua,

nếu không thì bạn chỉ dùng được 30 ngày.

- Nếu không thể dùng phần mềm phải mua này thì bạn dùng

file Width cũng có thể làm tăng độ rộng đường nét khi bạn

copy từ Autocad sang word (liên hệ tác giả để xin file).

Cách sử dụng file Width như sau:

 Chép file Width (xin từ tác giả hoặc tự kiếm trên mạng

internet) vào thư mục nào đó trong máy tính của bạn.

 Mở Autocad

 Từ màn hình Autocad, vào Tool  Load Applications 

Xuất hiện bảng Load / Unload Applications  nhập chữ

width.lsp vào ô File name hoặc tìm và chọn file width mà

bạn đã lưu trong máy tính bạn. Xong, nhấn Load  Close.
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Vẽ hình trên Autocad, sau đó làm tiếp các lệnh như sau:

 Command: wth 

 Color/LInetype/LAyer/Remove/Select/<Exit> S 

 Select objects: Chọn đối tượng   (2 lần enter)

 width: 0.5  (có thể nhập số khác, nếu bạn thích)

(Lúc này đường nét sẽ rộng lên)

 Tiếp tục, từ màn hình Autocad, ta chọn đối tượng cần copy,

ta nhấn Ctrl + C, sang màn hình Word, ta nhấn Ctrl + V. Như

vậy ta đã copy được hình từ Autocad sang Word như ý muốn.

Chú ý: - Đường elip, spline thì không dùng được lệnh wth.

- Đối với hình đa giác, đường kích thước, các block, …

thì ta phải dùng lệnh x  để phân rã chúng ra, sau đó mới

dùng được lệnh wth.
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Hình 7.7a. Copy từ Autocad 

sang Word không dùng lệnh 

wth (nét in ra rất mờ)

Hình 7.7b. Copy từ Autocad 

sang Word dùng lệnh wth 

(nét in ra như ý muốn)

Nhược điểm của WTH là thủ công, chậm, và có những

đường (ví dụ: elip, spline) thì không dùng WTH được
Ngoâ Baûo



162

4. TẠO VÀ QUẢN LÝ NHÓM (BLOCK)

a/ Khái niệm Block: Block là nhóm đối tượng liên kết với

nhau, dùng để sử dụng nhiều lần trong nhiều bản vẽ, không

phải mất thời gian vẽ lại.

Ví dụ:

- Trong bản vẽ xây dựng: Block ghế, cây cối, cửa,

- Trong bản vẽ điện, điện tử: Block khí cụ điện: IC, điot,

transitor, …

- Trong bản vẽ cơ khí: Block bulong, đai ốc, …

Hình 7.8. Một vài Block thường gặp
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b/ Tạo và quản lý các block

Nội 

dung

Lệnh

Block (b)

Hình minh họa

1. Tạo

nhóm
(block)

 Command: B 

 Xuất hiện hộp thoại định nghĩa block

(hình 7.9). Từ hộp thoại này, ta làm tiếp

như sau:

 Đặt tên block vào ô Name, VD: bulong

 Nhấp chuột trái vào Pick point

 Nhấp chuột trái vào 1 điểm nào đó

trên nhóm đối tượng (nhóm này đã được

vẽ trước).

 Nhấp chuột trái vào Select Ojects.

 Kéo chuột chọn hết nhóm đối tượng 

 Nhấp OK

Tạo block cho 

bulong

Bạn đọc tự

thực hiện tạo

block cho hình

sau:
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Nhập tên block

Tọa độ điểm cơ 

sở mặc định 

(không dùng)

Đơn vị đo

Liên kết

Chọn đối tượng

Chuyển thành 

block

Chọn điểm cơ 

sở  

Nhấp OK để kết 

thúc lệnh block
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Nội 

dung

Lệnh

Insert (i)

Hình minh 

họa

2.

Chèn

block

vào

bản

vẽ

- Nếu trong cùng một bản vẽ, bạn muốn đưa

block tới vị trí nào đó thì bạn chỉ cần dùng

lệnh Copy hoặc Move.

- Muốn chèn block từ bản vẽ này sang bản

vẽ khác, bạn có thể dùng Copy và Past. Tuy

nhiên, bạn nên dùng cách chèn block như

sau:

 Command: I  (I là viết tắt của Insert)

 Xuất hiện hộp thoại hình 7.10

 Nhấp vào nút Brownse...để tìm file hoặc

block cần chèn. Các file này chứa trong máy

tính bạn.

 Theo chỉ dẫn trong hình 7.10 để chèn

block vào bản vẽ.

Chèn block 

vào bản vẽ

Bạn đọc 

tự thực 

hiện chèn 

block như 

hình sau:
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Nhấp 

vào đây 

tìm file 

chèn

Hình 

block 

xem 

trước

Nhấp 1 

điểm 

chèn trên 

màn hình

Nhập tỉ 

lệ block 

cần 

chèn

Nhập 

góc quay 

block 

cần chèn

Đơn 

vị 

block 

chèn

Phân 

rã 

block

Tọa 

độ 

mặc 

định
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Vào Mycomputer  ổ đĩa C  Programs file 

Autocad 2007  Sample  DesignCenter  ta sẽ có nhiều

block thư viện có sẵn.

Các file này có sẵn

trong DesignCenter

của Autocad 2007.

Đây là nguồn thư viện

quan trọng, giúp ích

rất nhiều cho người

sử dụng Autocad.

Hình 7.11. Thư viện của Autocad 2007

Ngoâ Baûo



168

Nội 

dung

Lệnh

Divide (div)

Hình minh họa

3.

Chèn

block

tại

các

điểm

chia

 Ban đầu ta phải vẽ trước 1 đối tượng

ban và có 1 block ghe nào đó. Ta muốn

tạo 6 ghe xung quanh ban như hình b.

 Command: div 

 Select object to divide: Nhấp chọn đối

tượng.

 Enter the number of segments or

[Block]: b 

 Enter name of block to insert: ghe 

 Align block with object? [Yes/No] <Y>:

y  (quay đối tượng)

 Enter the number of segments: 6 

(cần 6 cái ghế xung quanh cái bàn)

Hình a: 

Chuẩn bị 

hình trước 

khi chèn 

block

ban

ghe
Điểm 

cơ sở 

tạo 

block 

ghe

Hình b: Sau khi 

chèn block tại 

các điểm chia
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Nội 

dung

Lệnh

Measure (me)

Hình minh 

họa

5.

Chèn

block

tại

các

điểm

chia

 Vẽ trước các hình như hình a. Lấy A

làm điểm cơ sở tạo block “nguoi”.

 Command: me 

 Select object to measure: chọn đối

tượng (chọn vòng tròn lớn, hình a)

Specify length of segment or [Block]:

b 

Enter name of block to insert: nguoi 

(phải tạo trước block với tên là “nguoi”)

Align block with object? [Yes/No] <Y>: y

 (quay đối tượng)

Specify length of segment: 5

Hình a: Chuẩn bị 

trước các hình

Hình a: Sau 

khi dùng lệnh 

measure

Điểm cơ 

sở tạo 

block
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BÀI TẬP CHƯƠNG 7

Bài 1: Hãy dùng phần mềm Better WMF hoặc file width và

lệnh Block để vẽ các hình sau:
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1321

Dùng l?nh Block và Div d? v? hình sau

5
8

5

Bài 2: Dùng lệnh Block và Divide để vẽ hình sau:
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Bài 3: Dùng lệnh Block và Measure để vẽ hình sau:

(Độ dài từng đoạn chia là 90)

669

2
9
5

670

2
9
5
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Bài 4: Dùng lệnh Block và Measure để vẽ hình sau:

(Độ dài từng đoạn chia tùy chọn)
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BÀI TẬP TỔNG HỢP AUTOCAD

Hãy vẽ các bản vẽ sau (nếu kích thước nào còn thiếu, người vẽ tự 

đề xuất)
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KHUNG TEÂN
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KHUNG TEÂN
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KHUNG TEÂN
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ĐỀ KIỂM TRA GIỮA KỲ (60 PHÚT)

Ghi chú: các kích thước không cho, học viên tự đề xuất

4000 48502400

4
7

7
0

4000

11250

2400 4850

11250

Người vẽ: ……………………………..

Ngoâ Baûo
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Ngoâ Baûo
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Ngoâ Baûo
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ĐỀ THI CUỐI KỲ, MÔN HỌC: VẼ AUTOCAD

PHẦN 1: AUTOCAD 2D (thời gian 45 phút)          5đ

Đề bài: Hãy vẽ lại bản vẽ dưới (đúng kích thước, đường nét, font chữ,

màu sắc), các kích thước không cho, học viên tự đề xuất.

Tp. HCM, 16/11/2011

GV RA ĐỀ

NGÔ BẢO
Ngoâ Baûo
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ĐỀ THI CUỐI KỲ, MÔN HỌC: VẼ AUTOCAD

PHẦN 2: AUTOCAD 3D (thời gian 45 phút)        5đ

Đề bài: Hãy vẽ lại bản vẽ như

hình bên (đúng kích thước,

đường nét, font chữ, màu

sắc), các kích thước không

cho, học viên tự đề xuất.

Tp. HCM, 16/11/2011

GV RA ĐỀ

NGÔ BẢO

Ngoâ Baûo
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ĐỀ THI AUTOCAD        Thời gian 90 phút

PHẦN 1: AUTOCAD 2D (thời gian 45 phút)          5đ

Đề bài: Hãy vẽ lại bản vẽ dưới (đúng kích thước, đường nét, font chữ,

màu sắc), các kích thước không cho, học viên tự đề xuất.

TRƯỜNG ĐH LƯƠNG THẾ VINH

LỚP: K.3 HM2 TC-ĐH XD1, K.4 HM2 TC-ĐH XD1 

VÀNG
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•

Đề bài: Hãy vẽ lại bản vẽ như

hình bên (đúng kích thước,

đường nét, font chữ, màu

sắc), các kích thước không

cho, học viên tự đề xuất.

Tp. HCM, 27/12/2011

GV RA ĐỀ

NGÔ BẢO

PHẦN 2: AUTOCAD 3D     5đ

(Thời gian 45 phút)       

Ngoâ Baûo
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DOANH TRAÏI BOÄ ÑOÄI

Ngoâ Baûo
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Cột 300x300, 6 cột

Tường dày 150

Ngoâ Baûo
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PHẦN 1 (5đ): THÍ SINH HÃY VẼ LẠI HÌNH SAU (ghi đầy đủ khung tên và kích thước)

ĐỀ THI SỐ …..
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PHẦN  2 (5đ): THÍ SINH HÃY VẼ LẠI HÌNH SAU:

GV RA ĐỀ THI

ThS. Ngô Bảo

Ghi chú: Thí sinh vẽ bằng Autocad 2008 trở lên thì lưu 

file dạng Autocad 2007 hoặc 2004
Ngoâ Baûo
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GV RA ĐỀ 

ThS. Ngô Bảo

A là ngày sinh, B là tháng sinh của thí sinh

PHẦN  2 (5đ): THÍ SINH HÃY VẼ LẠI HÌNH SAU:

Ghi chú: Thí sinh vẽ bằng Autocad 2008 trở lên thì lưu 

file dạng Autocad 2007 hoặc 2004


